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Why Use Emacs?

Why Use Emacs? Multidimensional Availability

All Platforms (Windows, Mac, Linux, Unix, Atari,...)

Across Time: Will Always Exist (because eager fanatics
maintain it)

Free & Open Source
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Why Use Emacs?

Why Use Emacs? Super Tools

Emacs has “major modes” for most languages and types of
files (C, C++, Lisp, R, SAS, Stata, LATEX, English, . . .).

Incredibly powerful text management tools

“compare” documents or buffers
Regular expression search and replace (even across many files)
Copy, paste, insert columns

Enormous power to edit very large files

At some point in the future, you may find that the only editor
that is capable for a particular project is Emacs. Prepare for
that time by using Emacs for other projects as well!



Emacs 6 / 71

Why Use Emacs?

Check the R FAQ

R FAQ, by Kurt Hornik (Version 2.15.2012-09-19):

6 . 2 Should I run R from w i t h i n Emacs?

Yes , d e f i n i t e l y . I n f e r i o r R mode p r o v i d e s a
r e a d l i n e / h i s t o r y mechanism , o b j e c t name
c o m p le t i o n , and syntax−based h i g h l i g h t i n g
o f t he i n t e r a c t i o n b u f f e r u s i n g Font Lock
mode , as w e l l as a v e r y c o n v e n i e n t i n t e r f a c e
to the R h e l p s y s t e m .

Of c o u r s e , i t a l s o i n t e g r a t e s n i c e l y w i t h the
mechanisms f o r e d i t i n g R s o u r c e u s i n g Emacs.
One can w r i t e code i n one Emacs b u f f e r and
send whole o r p a r t s o f i t f o r e x e c u t i o n to R ;
t h i s i s h e l p f u l f o r both data a n a l y s i s and
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Why Use Emacs?

Check the R FAQ ...

programming. One can a l s o s e a m l e s s l y i n t e g r a t e
w i t h a r e v i s i o n c o n t r o l system , i n o r d e r to
m a i n t a i n a l o g o f changes i n your programs
and data , as w e l l as to a l l o w f o r th e
r e t r i e v a l o f p a s t v e r s i o n s o f the c o d e .

I n a d d i t i o n , i t a l l o w s you to keep a r e c o r d
o f your s e s s i o n , which can a l s o be used f o r
e r r o r r e c o v e r y through the use o f t he
t r a n s c r i p t mode.
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Emacs Anatomy

Start Emacs. Here’s What I See

1: Pull Down Menus 2. Button Bar 3. Status Bar 4. Mini-buffer
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Emacs Anatomy

Terminology

Frame: That “whole thing”.

Window: The content display area inside a frame

Buffer: A chunk of “content,” (letters and words) that can be
shown inside a window.

Check for yourself.

Chose File -> Split Window. You can have 2 “windows”
showing same “buffer”
Choose File -> New Frame
Choose Menu Buffers to select a buffer to display in the
currently focused Window
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Emacs Anatomy

Emacs ”Major Mode” system

We want the editor to customize itself to the language we are
working with.

A display of R code should differ from Lisp or Java

Emacs will guess the mode you want from the file extension
(if you open a file)

Or you can specify the mode while inside the session
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Emacs Anatomy

Emacs ”Major Mode” system

Emacs automatically chooses the mode for you, from the file
name you opened.

Here’s how to manually change the mode, if you want to. (M
is the Meta key, usually “Alt”

M-x text-mode
M-x c-mode
M-x tex-mode
M-x R-mode
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Emacs Anatomy

Major Modes try to help with Formatting

The TAB key should indent a line.

Position the cursor ANYWHERE in a line and hit tab (Not
necessary to be at start of line).

SHOULD Indent properly.

Usually, languages want a certain number of spaces, and NOT
the literal TAB to be inserted. Emacs handles that.

The shortcut paragraph re-shape key, M-q, can be configured
to work very carefully, to re-shape long lines. It works very
well in the major modes for LaTeX, for example. Not so well
in ESS at the current time.
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Emacs Anatomy

Comment Characters

Programming languages differ in the comment symbol

Major modes generally know and can insert and arrange them
for you.

Hit TAB to force re-indentation

Comment and un-comment blocks.

1 Highlight a block of text
2 Hit the keystroke M-;.
3 In an R file, that inserts two pound signs at front of lines
4 If you insert one pound sign, text will get pushed to the right

when you hit TAB.
5 If you insert 3 pound signs, text will get pushed flush left
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No Learning Curve
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No Learning Curve

Understand the History of Emacs

Emacs was created in the days before

mice
multi-windowed “desktop” environments
Windows or Macintosh computers

Can still be used in a “keyboard” only world

Combinations using (C) Control, (S) Shift (S), and (M) Meta
key (usually “Alt”)
These are are featured in the Emacs tutorial
Note the prevalence of “Emacs cheat sheets” floating about on
the Internet
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No Learning Curve

Properly Understood, the Emacs Learning Curve is NOT
STEEP

If you have a

a mouse, and
Windows, Mac, Linux, or Unix

then Emacs will run with pull down menus.

It is tremendously programmable, most people can use Emacs
comfortably even if they don’t customize it.

Settings that seem unusual can usually be changed, and I’ll
handle most of that for you.
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No Learning Curve

Don’t Listen To People Who Want You To Memorize C-x
C-g C-h whatever...

You can learn key-stroke combinations later, if you need them.

But you don’t need most of them now.

What’s easier to remember?

Click the Edit Menu, Choose select all, or
Type C-x h (Control-x, release both keys, then the letter “h”)
I use the first way. (Why “h” for select all?)

What’s easier to remember?

Hit the “page down” key on the keyboard for a few seconds and
watch a file fly by, or
Type “M->” (Alt, Shift and the greater-than sign) to go to the
bottom



Emacs 19 / 71

No Learning Curve

Don’t Listen To People Who Want You To Memorize C-x
C-g C-h whatever... ...

I usually just hit “page down” for a moment. Yesterday I had R
output that was 150,000 lines and M-> would have been
useful.
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No Learning Curve

Example of Previous

Here is an example from “Experienced Programmers
Introduction to Emacs”
http://weatherall.4all2u.com/work/emacs.htm

Now to a more c o n v e n t i o n a l l e a r n i n g o r d e r
C−a move to b e g i n n i n g o f l i n e
C−e move to end o f l i n e
M−< move to the b e g i n n i n g o f t he f i l e
M−> move to the end o f t he t u t o r i a l .
C−k d e l e t e r e s t o f l i n e

<Delete> d e l e t e t he c h a r a c t e r j u s t b e f o r e t he
c u r s o r

C−d d e l e t e t he n e x t c h a r a c t e r a f t e r t he
c u r s o r

http://weatherall.4all2u.com/work/emacs.htm
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No Learning Curve

Example of Previous ...

To do those things, I use the mouse, delete key, and the arrow
keys in the obvious ways.

I don’t use Control key combinations that are unique to
Emacs very often. If I did, I’d feel helpless when I had to use
some other editor. The HOME and END keys work fine. Or
arrow keys. I would only need C-a if I had no arrow keys, and
no mouse!

I don’t deny the keystrokes might be faster, if you remember
them.

New users should not become preoccupied with memorizing C,
M and S sequences. Note frequent needs, then learn those
keystrokes.
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No Learning Curve

Another Intimidating Example

Useful Emacs bits ’n’ bobs
http://www.insectnation.org/howto/emacs-tips

Here ' s a few handy key c o m b i n a t i o n s I w i sh I ' d
been t o l d about when I s t a r t e d u s i n g emacs :

C−g or ESC ESC ESC : c a n c e l m i n i b r o w s e r s e s s i o n
C−s : s e a r c h f o r t e x t
C−r : s e a r c h f o r t e x t backwards
C−%: r e p l a c e t e x t ( p r e s s s p a c e to okay each

s u g g e s t e d i n s t a n c e
C−M−%: r e p l a c e r e g e x ( p r e s s s p a c e to okay each

s u g g e s t e d i n s t a n c e
C−[ s p a c e ] : p l a c e mark ( I don ' t use t h i s . . . s e e

above r e . r e g i o n s e l e c t i o n )
C−w: cut r e g i o n ( s t d emacs )

http://www.insectnation.org/howto/emacs-tips
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No Learning Curve

Another Intimidating Example ...

M−w: copy r e g i o n ( s t d emacs )
C−k : cu t l i n e
C−y : p a s t e ( yank )
C−l : r e c e n t r e b u f f e r window v e r t i c a l l y around

a c t i v e l i n e
C−x C−f : open ( f i n d ) f i l e i n b u f f e r
C−x C−s : s a v e b u f f e r to f i l e
C−x C−w: s a v e b u f f e r to new f i l e
C−x C−z : s t o p ( pause ) emacs p r o c e s s ( r e − s t a r t

w i t h s h e l l f g )
C−x k : k i l l b u f f e r
C−x b : change a c t i v e b u f f e r
C−x 1 : d i s p l a y o n l y c u r r e n t b u f f e r window
C−x 2 : s p l i t b u f f e r window
C−x 0 : k i l l c u r r e n t b u f f e r pane
C−x 4 f : open f i l e i n new window
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No Learning Curve

Another Intimidating Example ...

C−x 4 b : open b u f f e r i n new window
C−x 5 2 : open new frame
C−x 5 0 : k i l l c u r r e n t f rame
C−x 5 f : open f i l e i n new frame
C−x 5 b : open b u f f e r i n new frame
C−x o : s w i t c h between a c t i v e sub−window
C−x D: e n t e r t he v e r y n i f t y dired−mode
M−x global− font− lock−mode : t o g g l e s y n t a x

h i g h l i g h t i n g
M−x perl−mode : a l o t o f code h i g h l i g h t s f a i r l y

w e l l i n P e r l mode
M−x g o t o − l i n e : jump to l i n e
F10 : a c c e s s menus i n t e x t mode ( v i a t he

m i n i b u f f e r )
M−x b y t e − c o m p i l e − f i l e .emacs : c o m p i l e .emacs o r

a n o t h e r e l i s p f i l e f o r f a s t e r o p e r a t i o n
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No Learning Curve

Avoid the Emacs Tutorial Until Later

Emacs provides a nearly complete desktop environment.

The Emacs tutorial emphasizes memorization of keystrokes
that are not truly necessary with current Emacs.

Instead, listen to me! Use my init file. Make Emacs behave in
a more familiar way.

We don’t have to sacrifice on any of the other very powerful
features of Emacs

Emacs enthusiasts are able to remember hundreds of key
combinations, but I can’t.
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No Learning Curve

CUA Mode: Good Fix for Common ”Problem”

People are accustomed to cut and paste keys (from MS or
Macintosh):

keystroke result

C-x cut

C-c copy

C-v paste

C-z undo

Emacs default keystrokes are
keystroke result

C-w cut (“wipe” in Emacs-speak)

M-w copy

C-y paste (“yank” in Emacs-speak)

C- undo
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No Learning Curve

CUA Mode: Good Fix for Common ”Problem” ...

Fix. Turn on “CUA mode” in Emacs. Will make C-x, C-v, C-c,
C-z do what you expect.

I turn on CUA mode in my init file, but now it can also be
done in a pull down menu. Look under Options.

Potential problem: Emacs has many keystroke combinations
that use C and M and anything we do to “override” them may
cause trouble. But most of these CUA bugs have been solved.

As an example of a bug, try to read the Emacs Tutorial with
CUA mode on. (Click the Emacs Help menu, choose
Tutorial). The tutorial presumes you can type C-v to go to the
next “page” (in the old-fashioned terminal sense of displaying
the next “screen sized chunk”). It is necessary to turn off CUA
mode to make any progress inside the Emacs tutorial.
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No Learning Curve

CUA Mode: Good Fix for Common ”Problem” ...

Of course, the fact that the first thing in the Emacs tutorial is
how to see the “next screen” with C-v illustrates my previous
point, that the Emacs tutorial is addressed to a much different
user audience than this presentation.
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No Learning Curve

CUA mode Rectangular Selection Super-Power

Sometimes, you need to highlight a rectangular column of text
and copy and paste it.

This is a secret power of CUA mode! Very convenient

Here is the CUA way.

Move the cursor “top left” of a rectangle you want to select
Hit “C-return”
Use arrow keys to expand rectangle. Highlight will display a
rectangle.

Cut, copy, paste just work!.
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No Learning Curve

Customizations I Recommend

When Emacs starts, it reads a series of configuration files

Some are “system-wide”
Some are user specific (in the directory /.emacs.d)

I customize the settings thusly.
http://pj.freefaculty.org/Software/Emacs/init.el

An administrator can drop that file in the Emacs install folder
under site-lisp/site.start.d

A user should create a folder .emacs.d in their home folder
and drop init.el in there

Emacs will create “ /.emacs.d” folder for you if you use pull
down menu “Options -> Save Options”
.emacs.d is a “hidden” folder, a file manager may not want to
show it to you. Try harder.

http://pj.freefaculty.org/Software/Emacs/init.el
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Here’s my Emacs init file (on my laptop 2015-02-04

1 ;; Paul Johnson

2
3 ;; UPDATE: Because Emacs ESS changes made this MUCH easier , my

4 ;; re-work gets shorter :=)

5
6 ;; INSTRUCTIONS . Copy this file into the

7 ;; folder ∼/emacs.d, so its name would be ∼/emacs.d/init.el
8 ;; or copy it into the Emacs site-start .d folder.

9
10 ;; R USER PREVIEW.

11 ;; Here are my special features related to ESS with R.

12
13 ;; 1. Shift+Enter will send the current line to R, and it will start R

14 ;; if it is not running. ESS 13-05 chose instead CTL+Enter , which I

15 ;; DO NOT want because it conflicts with CUA mode.

16 ;; 2. R will assume the current working directory is the document directory.

17 ;; 3. R runs in its own "frame"

18 ;; 4. Emacs help pops up in its own frame.

19
20
21 ;; JUSTIFICATION . The intention is to make Emacs work more like a

22 ;; "modern" GUI editor.

23 ;; See my companion lecture

24 ;; "Emacs Has No Learning Curve"

25 ;; http://pj. freefaculty .org/guides/Rcourse
26
27
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No Learning Curve

Here’s my Emacs init file (on my laptop 2015-02-04 ...

28 ;; Paul Johnson <pauljohn@ku .edu >

29 ;; 2012-11-24

30 ;;

31 ;; Conflicts between Emacs-ESS and SAS usage forced me to make

32 ;; some changes. And for no benefit , as SAS mode still not great.

33 ;; I had to cut out a lot of framepop stuff.

34 ;;

35
36
37 ;; 2013-07-10 TODO: Find out if this is still necessary , or for

38 ;; which versions of windows.

39
40 ;; Section I. Windows OS work-arounds

41 ;; 20141222: seems unnecessary now

42 ;;(if (eq system-type 'windows-nt )

43 ;; (setq use-file-dialog nil))

44 ;; There 's been a chronic problem with file selection dialogs on Windows

45 ;; Maybe you commment previous out and see if your Windows is fixed.

46
47
48 ;; Org-mode with R doesn 't work without this

49 ;; http://orgmode.org/worg/org-contrib/babel/ how-to-use-Org-Babel-for-R .html
50 ( custom− set−var iab les
51 ' ( ansi−color−names−vector [ ”#2e3436 ” ”#a40000 ” ”#4e9a06 ” ”#c4a000 ” ”#204a87 ” ”

#5c3566 ” ”#729 f c f ” ”#eeeeec ” ] )
52 ' ( cua−auto− tab i fy− rectang les n i l )
53 ' ( custom−enabled−themes ( quote ( wh i t eboa rd ) ) )
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

54 ' ( org−babel− load− languages ( quote ( ( emacs− l i sp . t ) (R . t ) ) ) )
55 ' ( org−conf i rm−babel−evaluate n i l )
56 ' ( tab− s top− l i s t ( quote (8 16 24 32 40 48 56 64 72 80 88 96 104 112 120 4) ) ) )
57
58 ;; Section II. Keyboard and mouse customization

59
60 ;; IIA: make mouse selection work in the usual Mac/Windows way

61
62 ( de le te−se lect ion−mode t ) ; delete seleted text when typing

63
64 ;; In Linux , I see weirdness in Emacs 24 with paste and clipboard. Confusing !
65 ;; http:// stackoverflow .com/questions/13036155/

how-to-to-combine-emacs-primary-clipboard-copy-and-paste-behavior-on-ms-windows

66 ( s e t q s e l e c t−a c t i v e− r e g i o n s t )
67 ( global−set−key [mouse−2 ] 'mouse−yank−primary ) ; make mouse middle-click only

paste from primary X11 selection , not clipboard and kill ring.

68
69 ;; highlight does not alter KILL ring

70 ( s e t q mouse−drag−copy−region n i l )
71
72
73 ;; IIB: keyboard customization

74
75 ;; CUA mode is helpful not only for copy and paste , but also C-Enter is

rectangle select

76 (cua−mode t ) ; windows style binding C-x , C-v , C-c , C-z



Emacs 34 / 71

No Learning Curve

Here’s my Emacs init file (on my laptop 2015-02-04 ...

77 ( s e t q cua−auto− tab i fy− rectang les n i l ) ;; Don 't tabify after rectangle commands

78 ; ;20130717( setq cua-keep-region-after-copy t) ;; Selection remains after C-c

79
80 ;; write line numbers on left of window

81 ;; Caution: if you do this , it makes Emacs much slower !
82 ;;( global-linum-mode 1) ; always show line numbers

83
84
85 ;; Section III. Programming conveniences :

86 ( show−paren−mode t ) ; light-up matching parens

87 ( global−font− lock−mode t ) ; turn on syntax highlighting

88 ( s e t q text−mode−hook ( quote ( turn−on−auto− f i l l text−mode−hook− identify ) ) )
89
90 ;; Section IV. ESS Emacs Statistics

91
92 ;; start R in current working directory , don 't let R ask user

93 ( s e t q ess−ask− for−ess−directory n i l )
94
95 ;; ESS 13.05 default C-Ret conflicts with CUA mode rectangular selection .

96 ;; Change shortcut to use Shift-Return

97 ;; Suggested by Vitalie Spinu ESS-help email 2013-05-15

98 ;; Revision suggested 2013-09-30 to co-exist with Windows Emacs

99 ;; and the load order which has ess after user init file.

100 ( eva l−a f te r− l oad ”ess−mode ”
101 ' ( progn
102 ( def ine−key ess−mode−map [ ( c o n t r o l r e t u r n ) ] n i l )
103 ( def ine−key ess−mode−map [ ( s h i f t r e t u r n ) ] ' ess−eval−region−or− l ine−and−step ) )
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

104 )
105
106 ;; create a new frame for each help instance

107 ;; (setq ess-help-own-frame t)

108 ;; If you want all help buffers to go into one frame do:

109 ( s e t q ess−help−own−frame ' one )
110
111 ;; I want the *R* process in its own frame

112 ;; This was a broken feature in ESS , fixed now. Helps massively !
113 ( s e t q infer ior−ess−own− f rame t )
114 ;;( setq inferior-ess-same-window nil)

115
116
117 ;; In Spring 2012 , we noticed ESS SAS mode doesn 't work well

118 ;; at all on Windows , that lead to removal of lots of stuff

119 ;; I really liked. Even then , we couldn 't get much satisfaction .

120 ;;

121 ;; Following was needed for that , otherwise , it is not needed

122 ;; (load "ess-site ")

123 ;; ( ess-sas-global-unix-keys )

124
125
126 ;; ;; ;; Section V. Customize the use of Frames. Try to make new content

127 ;; ;; ;; appear in wholly new frames on screen.

128 ;; ;; ;;

129 ;; ;; ;; V.A: Discourage Emacs from splitting "frames", encourage it to pop up

new
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

130 ;; ;; ;; frames for new content.

131 ;; ;; ;; see: http://www.gnu.org/software/emacs/elisp/html_node/ Choosing-Window .
html

132 ;; (setq pop-up-frames t)

133 ;; (setq special-display-popup-frame t)

134 ( s e t q sp l i t−window−pre f e r r ed− func t ion n i l ) ; discourage horizontal splits

135 ;; (setq pop-up-windows nil)

136
137
138 ;; V.C: Make files opened from the menu bar appear in their own

139 ;; frames. This overrides the default menu bar settings. Opening an

140 ;; existing file and creating new one in a new frame are the exact

141 ;; same operations . adapted from Emacs menu-bar.el

142 ( de fun menu− f ind−ex ist ing ( )
143 ”Ed i t the e x i s t i n g f i l e FILENAME . ”
144 ( i n t e r a c t i v e )
145 ( l e t * ( ( mustmatch ( not ( and ( fboundp ' x−uses−old−gtk−dialog )
146 ( x−uses−old−gtk−dialog ) ) ) )
147 ( f i l e n ame ( ca r ( f ind− f i l e− r ead−args ”Find f i l e : ” mustmatch ) ) ) )
148 ( i f mustmatch
149 ( f ind− f i l e−other− f rame f i l e n ame )
150 ( f i n d− f i l e f i l e n ame ) ) ) )
151 ( def ine−key menu−bar−file−menu [ new− f i l e ]
152 ' (menu−item ”Open/ Crea te ” f ind− f i l e−other− f rame
153 : enab l e (menu−bar−non−minibuffer−window−p )
154 : h e l p ”Crea te a new f i l e ”) )
155 ( def ine−key menu−bar−file−menu [ open− f i l e ]
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

156 ' (menu−item , ( purecopy ”Open F i l e . . . ”) menu− f ind−ex ist ing
157 : enab l e (menu−bar−non−minibuffer−window−p )
158 : h e l p , ( purecopy ”Read an e x i s t i n g f i l e i n t o an Emacs b u f f e r ”) ) )
159
160
161 ;; V.D Open directory list in new frame.

162 ( def ine−key menu−bar−file−menu [ d i r e d ]
163 ' (menu−item ”Open D i r e c t o r y . . . ” dired−other− f rame
164 : h e l p ”Read a d i r e c t o r y ; op e r a t e on i t s f i l e s ( D i r ed ) ”
165 : enab l e ( not ( window−minibuffer−p ( frame−selected−window

menu−updating−frame ) ) ) ) )
166
167 ;; Section VI: Miscellaneous convenience

168
169 ;; Remove Emacs "splash screen"

170 ;; http://fuhm. livejournal .com/
171 ( d e f a d v i c e command− l ine−normalize−fi le−name
172 ( b e f o r e k i l l− s tup i d− s t a r tup− s c r e en a c t i v a t e )
173 ( s e t q i nh i b i t− s t a r t up− s c r e en t ) )
174 ( s e t q i nh i b i t− s p l a s h− s c r e en t )
175
176
177 ;; Show file name in title bar

178 ;; http://www. thetechrepo .com/ main-articles/549
179 ( s e t q f rame− t i t l e− fo rmat ”%b − Emacs ”)
180
181 ;; I'm right handed , need scroll bar on right (like other programs)
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

182 ;;( setq scroll-bar-mode-explicit t)

183 ;;( set-scroll-bar-mode `right)

184
185 ;; Make Emacs scroll smoothly with down arrow key.

186 ;; 2011-10-14

187 ;; faq 5.45 http://www.gnu.org/s/emacs/emacs-faq .html#
Modifying-pull_002ddown-menus

188 ( s e t q s c r o l l− c o n s e r v a t i v e l y most−pos it ive− f ixnum )
189
190 ;; adjust the size of the frames , uncomment this , adjust values

191 ;;( setq default-frame-alist '(( width . 90) (height . 65)))

192
193
194 ;; Remember password when connected to remote sites via Tramp

195 ;; http:// stackoverflow .com/questions/840279/
passwords-in-emacs-tramp-mode-editing

196 ;; Emacs "tramp" service (ssh connection ) constantly

197 ;; asks for the log in password without this

198 ( s e t q password−cache−expiry n i l )
199
200 ;; Section : Emacs shells work better

201 ;; http://snarfed.org/ why_i_run_shells_inside_emacs
202 ( s e t q ansi−color−for−comint−mode ' f i l t e r )
203 ( s e t q comint−prompt−read−only t )
204 ( s e t q comint−scroll−to−bottom−on− input t )
205 ( s e t q comint−scroll−to−bottom−on−output t )
206 ( s e t q comint−move−point−for−output t )
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Here’s my Emacs init file (on my laptop 2015-02-04 ...

207
208
209 ( custom−set−faces
210 ;; custom-set-faces was added by Custom.

211 ;; If you edit it by hand , you could mess it up , so be careful.

212 ;; Your init file should contain only one such instance.

213 ;; If there is more than one , they won 't work right.

214 )
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Selection of text

Default emacs keyboard uses C-space to begin a selection,
followed by movement keys.

A more modern sort of selection can be used.

This has changed in Emacs-23, so now it behaves in a more
usual way. Currently, it seems to work “correctly” if I include
only this in my init file.

( d e l e t e− s e l e c t i o n−m o d e t ) ; d e l e t e
s e l e t e d t e x t when t y p i n g
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Shortcuts I do remember

There are some keyboard shortcuts I do remember

C-s: I search frequently, this is easier than the menu Edit ->
Search (C-r searches in reverse)
M-%: Query replace
C-M-%: Regular-Expression Query replace (can’t live without
them)
M-x: execute commands.
C-g : get out of jail free. If you mistakenly start something in
the minibuffer, C-g gets out of it.
M-q : re-shapes an ill-formed paragraph
M-; : for a selected region, will “comment” and “uncomment”
all lines.

But for things that I only do once every 6 months, it is easier
to find them in a menu or type them by name.
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Using M-x

M-x tells the minibuffer to get ready for a command

TAB completion works inside there, so if you remember the
first few letters of a command, this is an easy way to do
things.

Example: indent code in a region

Highlight some text and type: M−x indent−region
After that, the indentation occurs, but Emacs minibuffer
reminds me I could have used a short cut:

You can run t he command '
i n d e n t − r e g i o n ' w i t h C−M−\

Repeat previous using TAB completion feature of minibuffer
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Using M-x ...

Highlight some text and type: M−x inden
Stop typing, hit the tab key once or twice. A set of legal
completions pops up, one of which is “indent-region”.
Middle-click the one you want to choose it
Hit enter

Example: accidentally open a read only file. Some file saved
from R sessions are marked “read only” automatically.
Tedious! I want to edit!. Emacs can try to make it writable.

Run M−x toggle−read−only
Emacs minibuffer pops up a reminder

You can run t he command ”
togg le− read−on ly ” w i t h C−x C−q

(thanks very much. Which is more memorable.
“toggle-read-only” or C-x C-q?)
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Using M-x ...

Maybe the joke’s on me here.

A reader of the first draft of this presentation pointed out that
in the Emacs status bar, there is a click-able thing to toggle
“read only.”

But it is hidden. Look in the left side of the status bar, for
two percent signs %%

hover the mouse over the first percent sign, and pops up
“buffer is read-only. Mouse-1 toggles”

It works fine, as long as you know its there. (Reminds me of
the secret doors in DOOM)
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Tools -> Compare. Example of a ”power feature”in Emacs

What’s the difference between two text files?

On my website, there is a copy of the Emacs config file I share
to people.
http://pj.freefaculty.org/Software/Emacs/

50emacs-ess-ku.el

That may not match my laptop. Perhaps I’ve tried some new
settings. My laptop has some features turned on that are
commented out in the version on the website.

I wonder, how far out-of-whack is my website with my reality?

1 Download 50emacs-ess-ku.el, open in Emacs.
2 Open ˜/.emacs.d/init.el (the current version of the same

config file).
3 In Emacs Tools menu, choose Compare, then 2 buffers.

http://pj.freefaculty.org/Software/Emacs/50emacs-ess-ku.el
http://pj.freefaculty.org/Software/Emacs/50emacs-ess-ku.el
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Tools -> Compare. Example of a ”power feature” in Emacs
...

2 things happen.

The different parts of the 2 buffers are color highlighted
A small window pops up in which I can Navigate the
differences.

Type “n” to step to the next difference between the buffers, or

“p” for previous.

Don’t forget to hit “q” to close the compare setup, and then it
makes you type “yes” in full to escape.
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R-mode is provided by the ESS package

1. ESS menu 2. Blue R starter (same as M-x R) 3. Send one line
to R 4. Send selection to R 5. Send current function to R.
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Start an R Session Within Emacs

Hit the big blue R button

Hopefully, R starts inside a buffer, which Emacs refers to in
the buffer list as *R*

If Emacs can’t find R in your system, you need to do some
configuration work so that the R/bin folder is added to your
system path (I have instructions for that in the crmda
computing documentation)
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Some People Prefer ”Splits” with Code and *R* like so

The bottom part is the ESS “R inferior mode”, a terminal in which
R is running
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ESS

I prefer Separate Frames with R
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Start Emacs within the Desired Working Directory

Don’t Start Emacs from an applications menu: It won’t know
where to look for files.

Make a directory structure, and run Emacs from within it. (In
Linux, just type emacs newFile.R to start).

On many OS, the easiest way to do that is to copy an R file
into the desired directory, and then open that file with Emacs.

Open an R file, Emacs automatically knows to turn on
R-mode (ESS Menu & Buttons)
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I’m Willing to Fight For Frames

I want separate Frames!

Spawning more Frames is very un-Emacs-like because it goes
against the decades-old tradition of Emacs (during which time
one could only have one Frame on one terminal).

Much of my Emacs init file is aimed at forcing Emacs to Start
Frames with new content, rather than simply starting new
buffers that over-write windows I’m using.

This is an area where reasonable people can disagree, I’m just
telling you what I like. I don’t want Emacs to be my window
manager, I want the OS to handle that.
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Using ESS button bar

Some of the very eager Emacs-ESS users say they remove the
button bar and the menus because they are distracting. I
can’t imagine...

I often use the big blue R button to start R.

Sometimes I use M-x R, just to prove I still can. (There was a
time when Emacs for Windows had no button bar, so the M-x
R was the only way.)

After starting R within Emacs, run “getwd()” to make sure the
working directory is correct.

The function evaluator is really handy. While revising a
function in code, hit that button and Emacs sends the whole
function to *R*.
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ESS Menu

The ESS menu teaches you the
keyboard shortcuts. You can
decide if you like them.

Eval versus Eval-and-go.

Eval commands send
instructions to *R*.
Eval-and-go send the
instructions and transfer the
focus to *R*
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Roxygen

Roxygen is a framework for generating R documentation files

In the “olden days” (last year), an R package would have
separate files for R functions and the help files that went with
them.

Problem: programmers found it tedious to maintain the
separate help files

The package roxygen2 (by Hadley Wickham, Peter
Danenberg, and Manuel Eugster) addresses that by

creating a “language” for writing documentation inside R code
files
providing functions to translate the result into documentation
files



Emacs 57 / 71

ESS

Roxygen ...

Even if you aren’t writing a package, the Roxygen style might
be a nice way to prepare your documents.

Suppose a function is declared like so

myFabFunc <− f u n c t i o n ( x , y , z , a ) {
x ∗ y ∗ z ∗ a

}

Click on the first line and from the ESS menu, choose
Roxygen and “Update/generate template”.

Observe a skeleton is created in which the function can be
described
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Roxygen ...

##' .. content for \description{} (no empty

lines) ..

##'
##' .. content for \details{} ..

##' @title

##' @param x

##' @param y

##' @param z

##' @param a

##' @return

##' @author pauljohn

myFabFunc <− f u n c t i o n ( x , y , z , a ) {
x ∗ y ∗ z ∗ a

}
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Roxygen ...

If we then fill in the sections, we will have pretty good
documentation for the function and it will be package-ready
(more or less).



Emacs 60 / 71

ESS

ESS Magic I Don’t use Menus and Buttons For

My shortcut: Shift+Enter sends the current line of code to
*R*. I think that’s convenient.

Instead, you could :

Hit the ESS button with one arrow:
Or type: C-x C-n.

Edit an existing function object:

C-c C-d
The mini buffer answers, Object to Edit :
type the name of some function, such as “lm”
Emacs opens a buffer called “username.lm.R”, which shows the
code for linear models
We can edit that file, and then re-load it into R with
C-c C-l
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ESS Magic I Don’t use Menus and Buttons For ...

After that, when you run functions that access lm, your new
version of that function will be used.
To test this, run C−c C−d lm and in the beginning insert
“browser()”.
Then run lm, or simply“example(lm)”. When the computations
come to the line where you put in “browser()”, the *R*
terminal will stop and give you a chance to interact with the
inside of that function.
To me, that is a fun feature. However, I just got an email that
indicates it is controversial. (See ESS- Emacs Speaks
Statistics” Version 12.04-4, Section 3.4: Philosophies for using
ESS. The current ESS core team believes that the R code files
are the “real” stuff on which we should be working, not fiddling
about with functions in memory.)
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ESS Help Mode

While reading a help file in Emacs, it is possible to run the
example code

Example. In *R* window, ask for help on lm

> ? lm

Emacs will open the help file and the menu at the top will
have an ESS-help menu

In the help file, move the cursor to one of the examples at the
end of the file.

Click the ESS-help menu and choose “Eval Line” or one of the
other options.
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Transcript Mode. Record Keeping.

In the perfect world, here is what happens.

1 Save the R code file.
2 Close R. Then Re-start R (so we have a clean canvas).
3 Step through your R code file line-by-line to be sure everything

runs properly
4 Save the output file with the extension *.Rout (that means it

becomes a “transcript” file).
Some people use the extension *.Rt for transcript files, but for
me it doesn’t work (don’t know why, yet)

As long as you have the R code and the transcript file, you
have all the records you need for future reference.

What if you are working on an R code file, but you type some
commands into the *R* buffer interactively?
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Transcript Mode. Record Keeping. ...

I do that all the time. While I’m testing code, I experiment in
the *R* buffer, then copy commands back to the R code file.

I should save the *R* buffer in a file *.Rout. Let’s suppose I
did.

The following problem may arise.

I open a new R session
I run the R code file that seemed good, but then it fails!
How can that be? It worked before?

Obviously, something I typed interactively in the *R* buffer
did not get copied into the code file properly.

Solution strategy.

Open the *.Rout file in Emacs.
Emacs recognizes that this is a transcript file
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Transcript Mode. Record Keeping. ...

Emacs won’t let me edit that transcript because it is marked
“read only”, so I either have to copy it to a new file or M-x
toggle-read-only.
Then

1 Select All of the text (either Menu Edit -> Select All, or type
“C-x h”)

2 In the ESS-trans menu, choose “Clean”.

Viola! That will erase all the output from that file, and leave
behind only the commands that were run.

Along the same lines, from a reviewer of these slides, I
received an email about an ESS feature. Since ESS 12.03,
there is an R automatic output “scrub and paste.” The key
sequence is C−u C−u C−y.
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Transcript Mode. Record Keeping. ...

Highlight some material in an *R* output window. It should
include commands and output.
Copy that selection (To copy, use either 1) M-w or 2) C-c from
CUA or 3) Edit menu).
Move the focus to an R code file where you want to paste in
only the R commands, no output.

If you do the ordinary paste, with C-y, you get all that messy
output.
But this key sequence will “clean” and paste the resulting R
commands.

C−u C−u C−y

Note, this requires the traditional C-y (“yank”) to paste, not
the CUA C-v.
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Emacs in Retrospect

I think the documentation and publicity that goes with Emacs
does it great dis-service.

Bill Venables, is credited with the quip: “The first five years of
Emacs are the worst; after that, it’s just difficult.”

When I first tried Emacs, I looked through the tutorial and I
thought “this really is trouble.”

I’ve told people that “Emacs is like Democracy,” adapting the
comment that Winston Churchill made to the House of
Commons, 1947-11-11, “Democracy is the worst form of
government, except for all those other forms that have been
tried from time to time.“

Almost all of the really smart people I know use Emacs.
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Do I Really Believe There is No Learning Curve?

Of course not.

But I’ll get more hits in Google than with my original title,
“Emacs Learning Curve 77% Less Steep Than Previously

Believed”

I honestly believe that if people are willing to try Emacs “my
way,” they can use it comfortably and benefit from many
powerful features.

It is not necessary to memorize a raft of key sequences, even
though many Emacs experts do so.
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Emacs is Extensible

I’m not denying the fact that

Customizing Emacs is possible, enriching, and frustrating (all
at the same time)

Some parts of Emacs are still difficult for me

The help menus are still as confusing to me as ever.
I find the Customization menus still very difficult.

If a person is willing to use Emacs with the init file I provide,
using Emacs can be a very reasonable experience.
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Useful Websites

Introduction to Emacs: http:

//cs.earlham.edu/~psg/tutorials/vtwm_emacs/part2.html

http://cs.earlham.edu/~psg/tutorials/vtwm_emacs/part2.html
http://cs.earlham.edu/~psg/tutorials/vtwm_emacs/part2.html
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